
Windows Draw makes it simple to create all kinds of drawings, flyers, brochures, postcards, or 
whatever else you can think up! All this creativity can be yours in just three basic steps.
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There are two ways to begin a drawing in Windows Draw. When you open 
Windows Draw or click New on the File menu, the Welcome screen opens.
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You can either start with a blank page or start with the Project Wizard.
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If you select Start With Blank Page on the Welcome screen, a selection of 
blank page types opens from which you can choose.
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Once you select a page type, you are presented with options specific to the 
page type. For example, if you choose Greeting Card, you must specify the 
page size and the kind of fold.
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Selecting Start With Project Wizard on the Welcome screen opens a selection 
of projects from which you can choose.
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A project is a pre-designed drawing that you can use as a starting point. 
Once you choose a project, you are able to personalize the drawing right 
from the wizard!
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Once you have a drawing on the page, you can change the drawing in 
various ways.
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You can draw new 
objects.

You can change 
objects.

You can delete 
objects.
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Use the Insert tools to draw or add new objects to your drawing.



}
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You can draw 
different shapes, 
lines, or borders.

You can add text. Your text
can be with or without 
margins. It can even be 
attached to objects as 
label text.

You can insert clip 
art, images, or OLE 
objects.
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You can change objects in your drawing by changing format attributes, size 
and position, and shape.
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Format attributes 
include color, line 
style, font, and 
shadow.

You can change the size 
of an object, or move the 
object around the page.

Change the shape 
of an object by 
moving anchor 
points or changing 
the curvature of 
lines.
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When you finish your drawing and it looks exactly as you want, you can save 
the drawing. But, you probably also want to output the drawing so you can 
show other people your creation!
The Output Wizard provides several ways of outputting your drawing.
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The most obvious 
way to output your 
drawing is by 
printing to paper.

You can save or e-mail 
your drawing.

The Output Wizard also
lets you save a 
drawing as a Web 
page. You can also 
save a drawing as an 
animated GIF, which 
can be used on a Web 
page.



In Windows Draw, order refers to the sequence in which objects display on the screen and the order 
in which they print.
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Draw, the default order of objects is 
the same as the order in which you 
create them. New objects are placed 
on top or in front of older objects. 
This is only apparent when objects 
overlap.

Objects are ordered from front to back, but you can also think of ordered objects as a stack. You 
stack new objects on top of existing objects.
When ordering objects, you can use the Send to Back or Bring to Front commands.
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Using the Send to Back command 
moves the selected object to the back 
or the bottom of the stack.

The Bring to Front command moves 
the selected item all the way to the 
front or top of the stack.

The other ordering commands are Send Backward and Bring Forward.
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Sending an object backward moves it 
back or down one level in the stack.

Likewise, bringing an object forward 
moves it one level toward the front or 
top of the stack.

Layering is similar to ordering, but on a larger scale. Windows Draw lets you create layers on which 
you can place many objects. Layers help you organize more complex drawings by letting you place 
similar objects on one layer.
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You can create a background on one 
layer.

Then place objects in the foreground 
using another layer. You can move and 
edit these objects without disturbing the
background.

{ewc DIBVIEW, MGXDIBVIEW, !
or550.bmp}

Of course, when the layers are viewed together
or printed, you see the entire picture. This has 
the same result as placing a foreground 
transparency on top of a background 
transparency on an overhead projector.
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Click the layer tabs to switch between 
layers.

To create new layers for a drawing, use the 
Add Layer command. A dialog box opens 
letting you give the layer a meaningful name.

You can assign certain attributes to layers using the Layer Manager. You can access the Layer 
Manager from the Layers option on the Draw menu.
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layers at once, make a layer invisible on 
screen, and make a layer non-printable. 
Layers can also be locked. When a layer 
is locked, you cannot make any changes
to objects on the layer.
Remember, object ordering applies only 
to objects on an individual layer. When 
you select one of the ordering 
commands, only the objects on the 
current layer are affected. The layer on 
which an object resides takes 
precedence over the object order.



In Windows Draw...
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Objects can be manipulated 
individually.

Or, objects can be selected 
together and manipulated all at 
once.

Windows Draw gives you two methods for manipulating multiple objects. First, you can use one of 
the Windows-standard methods of selecting multiple objects.
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Click the first object, then hold the 
SHIFT key while clicking the other 
objects.

Or, block-select by dragging a 
rectangle completely around the 
objects.

Once you have multiple objects selected, any commands you perform apply to all selected objects. 
However, multiple selection is temporary; it ends once you make another selection.



The second method for manipulating multiple objects involves creating a group. A group is a special 
type of object, created by combining other objects. To create a group...

Step 1: Select multiple objects as 
described on page 2.

Step 2: On the Tools menu, click 
Group, or click the Group button 
on the Drawing toolbar.
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The objects look the same whether 
they are grouped or selected. 
However, the objects stay together 
as one and are displayed in the 
status bar as a grouped object. 
Groups stay together until you 
ungroup them.

Groups can be treated as a single object for most purposes. For example...
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You can resize a group just like any
other object.

Or, change the fill color of a group 
and all the objects inside the group 
acquire the new fill color.

And, since groups become objects like any other Windows Draw object, it is even possible to create 
groups that contain other groups. Much of the clip art included with Windows Draw is grouped in this
manner.



As with all objects in Windows Draw, groups have their own edit actions. Editing individual items 
within a group is called the group edit mode. To start the group edit mode...
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Click the right mouse button and 
select Edit Group from the 
shortcut menu.

Or, simply double-click the group. 
Hatch marks appear around the group
being edited.

While editing a group, you can manipulate objects as if they were individual objects. For example, 
you can...
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Select an individual object and move, resize, or even delete it. Or, insert a new object, which 
becomes a new element of the group.

To affect the entire group again, or manipulate other objects on the page, you must leave the Edit 
Group mode. To leave this mode, either press the ESC key or double-click outside the group.



In Windows Draw, you can merge information from an address list with a drawing. This is similar to 
the mail merge function of a word processor.
You create a database of names and addresses and insert placeholders on a drawing for fields in the
address list. When you print a drawing containing placeholders, the information from an address list 
prints instead of the placeholders.
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On the drawing, a 
placeholder for First Name 
appears.

When you print the drawing,
the first name from a record
in the address list appears.

The Address List is where you enter names and addresses. When you enter information into the 
Address List dialog box, Windows Draw creates a tab-delimited text (TXT) file. This means a tab 
separates the information in each field.
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You can use any tab-delimited text file, comma-delimited text file, or Print Shop Address List file. If 
you want to create your own address text file, you can use a word processor or spreadsheet 
program. However, you must place the information in the correct order. (See online help for more 
information.)



You can specify the sort 
order of the records in 
your address list. When 
you open an address list, 
it is sorted by the current 
sort options. To change 
the sort order, use the 
Sort Options button.

The records can be sorted
by any field in the 
Address List. The sort 
options can not be saved 
for an individual file.
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When you create a drawing, you can insert placeholders for field names in your drawing. Use the 
Field From Address List command on the Insert menu.
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When you select 
Company from the 
menu, the Company 
placeholder appears on
the page.



When you print a drawing containing field placeholders, Windows Draw opens a wizard letting you 
choose the address list you want to use. At this time, you can also choose the names from the list 
you want to include in the printing.
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A drawing prints with the information from the Address List for each name selected.



Graphics can be stored in two types of files: Images and Drawings.
Images are graphics composed of dots. These dots are called pixels.
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Images are stored as a 
rectangular matrix of 
pixels. An image can have 
thousands of pixels, and 
the size of the image is 
measured according to the 
number of pixels wide by 
the number of pixels high.

When you use a scanner to scan a photograph, you create an image file. Images are used for 
photographs because images generate a realistic representation of the photo.
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Commonly, image files are identified with a filename extension of BMP, PCX, TIF, GIF, or JPG.



You can create or edit image files using image editing software, such as PhotoMagic.
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tools associated with painting. You can 
use paint brushes of various sizes, air 
brushes, and filters that lighten or 
darken. You can also automatically apply 
special effects, such as watercolor or 
embossing.
When you make changes to pixels, such 
as changing the color, the original color 
of the pixel is replaced with the new 
color. Using this method, you are also 
able to erase pixels by replacing the pixel
color with the background color.

An image can have anywhere from two colors (black and white) to 16 million colors. The resolution 
of an image is the number of pixels per inch. The more pixels per inch, the sharper the image.
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Two-color image 256-color image

Remember, the number of colors and the resolution affect the size of the image file. A high-color, 
high-resolution image has a larger file size than a two-color, low-resolution image.



Drawings are composed of straight lines and curves rather than a map of pixels. These lines and 
curves make up the individual objects contained in a drawing.
For example, each balloon is made up of several objects.
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Each object has its own attributes, such as color, size, and position.



Since each object in a drawing is maintained as a separate item, you can make changes to an object
without affecting other objects in the drawing.
For example, when you move an object, the remaining objects are unaffected. The object you 
moved still exists; however, the position attribute has changed.
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Windows Draw is software used for creating and editing drawings. Drawing software contains tools 
for selecting, rotating, positioning, and sizing objects. You can draw objects using line and curve 
tools. There are also shape tools that let you easily create shapes such as rectangles and circles.
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Select Rotate Position Size
Clip art is commonly stored as a drawing file. Many drawing files can be identified with the filename 
extensions of DRW, DS4, DXF, and CGM.



When creating a drawing, you often need to line up the edges of objects. This can be difficult.
Windows Draw provides a grid to be used as a guide when lining up objects.
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To make lining up objects even easier, objects snap to grid dots. When you move or resize an object 
where the edge is near a gridline, the line "attracts" the object, snapping it to the line. This ensures 
objects are aligned properly.
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By default, the grid contains 16 units per inch (10 units per centimeter). This means objects snap 
every 1/16" (or 1/10 centimeter).

You can change this 
setting so you have 
a larger or smaller 
grid. You can also 
choose to snap to 
the grid without 
showing grid dots, or
show grid dots 
without snapping to 
the grid.
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You can quickly turn grid snapping on or off by selecting Snap to Grid 
on the Draw menu or clicking the Snap to Grid button on the toolbar.



You can also set the scale of a drawing. If you are drawing a map or deciding where to place your 
furniture in a room, for example, you can set the scale accordingly.

If you are drawing a map, you
can set the scale so that one 
inch represents one mile on 
the drawing.
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To change the grid and scale of a drawing, click Grid Options from the Draw menu.



Each object you draw has a set of 
attributes or properties. These 
properties include position, size, 
color, and line style. You can set 
these properties using the Object 
Properties dialog box.
There are seven tabs, each 
displaying a panel on which you set
the Fill, Line, Line Ends, Shadow, 
Text, General, and hyperlinks 
properties.
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There are several fill styles from which you can choose. All options display a sample of your choices.
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An object with 
no fill is 
transparent.
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When Pattern is selected, 
several patterns display from 
which you can choose. You 
can also specify the 
background and foreground 
colors.
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If you choose 
Solid, the 
selected object 
is filled with the
color you 
specify.
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The gradient option displays 
several gradient styles from 
which to choose. You can 
specify the start and end 
colors.

The Line and Ends panels lets you set the line style and thickness, line ends, caps and corners for 
thick lines, and line color.
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 Lines can be solid, dotted, or dashed. 
You can set the size of the line from 0 
(hairline) to 72 points.

Lines can have arrows, squares, 
triangles, or circles on the ends. You can 
set the style and size of both the start 
and end of the line.
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When you have very thick lines, you 
can select the style of line caps and 
how corners fit together. The thick 

You can also set the color of the selected
line.



line in this example has beveled 
corners.

You can place a shadow behind an object in your drawing. The Shadow panel lets you set the type, 
color, position, and depth of the shadow.
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The simple shadow 
offsets the object.

The block shadow is 
connected to the object.

The soft shadow is a 
gradient.

You can select a color for the shadow. If the shadow is a soft shadow, you set the color and the blend
color. The shadow color fades into the blend color. The shadow position can be either lower left, 
lower right, upper left, or upper right.



The Text panel lets you select the font, size, style, color, and background color of text.
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The General panel lets you numerically set 
the location and size of an object. You can 
also give the object a name, and place the 
object on a different layer.
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Object properties can be set as defaults 
to be applied to new objects. You can set
new default properties by opening the 
Object Properties dialog box while no 
object is selected. Or, you can select 
Default Properties from the Format 
menu.
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The status bar displays the default line 
and fill properties. In this case, the 
default line is thin and white. The 
default fill is a blue linear gradient.

Once the properties have been set for one object, you may want to use the same properties on 
other objects in the drawing. There are two ways to copy styles from one object to another.

Method 1: Method 
2:
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Select the object with 
the properties you 
want to copy, and click
Pick Up Style on the 
Format menu.
Then, select the object
to which you want to 
apply the styles, and 
click Apply Style on 
the Format menu.
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To apply styles to 
multiple objects, you 
can use the Format 
Painter. Select the 
object with the 
properties you want to
copy, and click the 
Format Painter button.
Then, click the objects 
to which you want to 
apply the styles.

To copy the default properties to objects in your drawing, use the Format menu or Format Painter 
with no object selected.



There are many reasons people create and use graphics. Sometimes, creativity is the motivation for 
drawing a graphic. Other times, graphics are created as visual aids or to spruce up a text document.
Clever graphics can make information more clear and even more interesting. Windows Draw is an 
excellent tool for creating graphics for presentations, newsletters, reports, and flyers. You can also 
use graphics just for fun to create games, banners, cards, or anything imaginable.
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Often you use software, such as a word 
processor, to create newsletters or 
presentations. Word processing, 
desktop publishing, and presentation 
software have limited drawing tools 
compared to drawing software.

When you insert a graphic into another application, you must use a file format the application can 
accept. Therefore, when you save the graphic in Windows Draw, you must save in the file format 
needed.
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Windows Draw files are saved with
the filename extension DRW. 
Some applications accept this 
format. When you need to use a 
different format, select the format 
in the Save as Type box.

Besides saving a drawing in a different file format, you can get drawings out of Windows Draw by 
printing, copying and pasting, dragging and dropping, and Object Linking and Embedding (OLE).



Printing

You can print drawings and images from Windows Draw. You can print both color and grayscale 
(shades of gray).
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Copying and Pasting

Copying and pasting uses the Windows Clipboard. The Clipboard is temporary storage for anything 
you copy using the Copy command. When you copy to the Clipboard, the contents can be pasted to 
the same or a different document. The contents remain on the Clipboard until a new item is copied.
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To copy an object to the 
Clipboard, select the object, 
then click Copy on the Edit 
menu. Or, click the Copy 
button on the toolbar.
To paste the contents of the 
Clipboard into another 
application, open the 
application and click Paste on
the Edit menu. Or, click the 
Paste button on the toolbar.
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Copy

Paste

Dragging and Dropping

Dragging and dropping lets
you use the mouse to 
move an object from 
Windows Draw to another 
application.
To drag, select an object 
with the left mouse button 
and, without releasing the 
mouse button, move the 
object to the application. To
drop the object, release the
mouse button.
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OLE

With OLE, you have the ability to 
edit the graphic without closing 
the program in which the graphic
was inserted. For example, if you 
insert a graphic into word 
processing software using OLE, 
you can double-click the graphic 

The word 
processor 
is open, 
and 
Windows 
Draw tools 
display for 
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to make changes on the spot.
Windows Draw accepts objects 
from other programs, as well as 
place objects into other 
programs. However, some 
applications have limited or no 
OLE capabilities.
Use either Paste Special on the 
Edit menu or Object on the Insert
menu to place an OLE object into
another application.

editing the 
graphic.



In Windows Draw, there are three modes to use when drawing objects: Insert, Select, and Edit.
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You are in the Insert 
mode when you have 
nothing on the page 
selected. You are able 
to insert objects using 
the Insert tools.

The Select mode lets
you choose objects 
on the page. To 
make a change to an
object, you must 
first select it.

To make changes to 
the shape of an 
object, you must use 
the Edit mode. You 
can modify the shape
of a curve or angle of 
a line using the Edit 
mode.

The Insert mode has many tools for creating drawings. You can draw lines, shapes, borders, and add
text to a drawing. These tools can be found on either the Insert menu or the Insert toolbar.
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There are two types of shapes in Windows Draw: Shapes and CoolShapes. There are also two types 
of lines: Lines and Connector Lines.
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you can choose from 
straight, jointed, right-
angle, arc, curve, or free-
hand lines.

Connector lines are just 
like basic lines except 
these lines connect to 
objects. Connector lines 
snap to connector points 
on objects and remain 
connected even if the 
object is moved.

You can draw basic 
shapes, such as circles 
and rectangles. These 
shapes can easily be 
drawn by clicking and 
dragging the mouse.
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CoolShapes are more complex shapes 
such as stars, pyramids, and arrows. 
When drawing polygons and stars, you 
can indicate the number of sides you 
want the shape to have.
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can draw fancy lines, 
frames, and borders. 
There are several different
styles of lines and frames 
from which you can 
choose.

Use the ArrowShape tool 
to draw different kinds of 
arrows by just clicking and
dragging. You can choose 
from shaded arrows or 
plain arrows.

Use the Calendar tool to draw a calendar for any month of any year.
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Text can be placed on a drawing as a text object, label text, or label text on a curve.
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A text box forms 
boundaries for the 
text. Therefore, 
the text wraps to 
fit within the 
boundary.
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Label text is an attribute of an 
object. If you move the object, the 
text remains part of the object. To 
attach label text to an object, just 
select the object and begin typing.

Label text can be made to fit the 
shape of the object. You have 
several options for placing text on 
a curve.

The Select tool and the Rotate/Slant tool both let you select, resize, move, and change attributes. 
However, the Rotate/Slant tool goes a step further.
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with the Select tool, square 
handles appear around the 
object. You can drag these 
handles to resize the object.
An object selected with the 
Rotate/Slant tool has a rotate 
handle, a pivot point, and 
slant handles. Drag the rotate 
handle or a slant handle to 
rotate or slant the object. You 
can move the pivot point to 
allow rotation from a point 
other than the center.

With an object selected, you can edit the shape of the object with the Edit mode. An Edit menu 
opens when you click the Edit button on the toolbar. The options in the menu change depending on 
the selected object.

{ewc Mvmci, Mvmci,    [autostart][noframe] edit0010.avi}
Each object has a unique 
editing method. When you
edit a rectangle, edit 
points appear. The corner 
point lets you round the 
corners.

When you edit points, a 
set of points appear, 
letting you change the 
angle of lines. You can also
add or subtract points and
edit multiple points at 
once.

When you edit curves, you
see the same points as 
when editing points. 
However, when you click 
on a point, you can 
change the curvature of 
the line.
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Merging Names and Addresses with a 
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Web Pages and Animations

{ewl 
DIB
VIE
W, 
MGX
DIB
VIE
W, !
Icon.
BMP
}

Drawing Modes: Inserting, 
Selecting, and Editing 

{ewl
DIB
VIE
W, 
MG
XDI
BVI
EW,
!
Icon
.BM
P}

Power-User Tips



In Windows Draw, you can reshape objects by changing the angle and curvature of lines. Each 
object has points that can be manipulated.

{ewc DIBVIEW, MGXDIBVIEW, !pt150.bmp}
{ewc mvmci, mvmci, [autostart][noframe] pts0001.avi}

The Edit Points command lets you 
change the position of points.

The Edit Curves command lets you
reshape the curvature of a line.

You can access the Edit Points and Edit Curves commands from the Edit menu, the shortcut menu 
(click the right mouse button on the object), or the Edit button on the Insert toolbar.
When you choose one of these commands, the Reshape toolbar opens.

{ewc DIBVIEW, MGXDIBVIEW, !pt250.bmp}



When you edit points, default points appear on the object.

To reshape the object, click a
point. The point changes 
colors to indicate it is 
selected. Then, drag the 
point to a different location.

{ewc 
mvmci
, 
mvmci
, 
[autost
art]
[nofra
me] 
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3.avi}

You can select and edit multiple points at once. To select multiple points, hold down the SHIFT key 
while clicking the points. When you drag one point, all selected points move together.



When you edit curves, the same default points appear on the object as when you edit points. 
However, when you select a point and drag it, a line and control points appear that let you shape 
the curve.

{ewc mvmci, mvmci, [autostart][noframe] pts0004.avi}



The Smooth and Unsmooth buttons on the Reshape toolbar let you automatically create a smoothed
or sharp point.

{ewc DIBVIEW, MGXDIBVIEW, !pt550.bmp}
Smooth       Unsmooth



When editing the angles and curves of an object, you may need to change the number of points on 
the object. You can add and delete points as necessary.

{ewc mvmci, mvmci, [autostart][noframe] pts0006.avi}
To add a point, click the Add 
Point button. Then, click the 
edge of the object where you 
want the point. Edit the point 
as necessary.

To delete a point, click the 
point you want to delete. 
Then, click the Delete Point 
button.

You can add or delete multiple points in sequence by pressing the CTRL key while adding and 
deleting points.



The Slice tool lets you separate a point into two points. The Join tool lets you connect end points.
{ewc mvmci, mvmci, [autostart][noframe] pts0007.avi}

Click the Slice button, then click a point. 
The point becomes two separate end 
points. If the object is filled, the fill color 
is removed because the object has 
unconnected points.
If you want to slice a line somewhere 
other than an existing point, you can click
anywhere on the line and two end points 
are created.

If you click the Join button, the end 
points of the selected object are 
joined together.



As you become more familiar with the features of Windows Draw, you will want to use special 
features that make you a more efficient user.
Shortcut Menus

The shortcut menu is an easy way to access 
commonly used features. Access the shortcut 
menu by clicking the right mouse button on an 
object or area of the Windows Draw window.
Right-clicking an object displays a menu 
containing editing, ordering, and properties 
options.
You can hide or show toolbars by right-clicking 
the toolbar area. You can display layer options 
by right-clicking the layer tabs. Right-clicking a 
blank area of the drawing page displays a 
menu of general options.

{ewc DIBVIEW, 
MGXDIBVIEW, !
tp150.bmp}

Default Editing Mode

If you want to access the default editing mode, you can double-click an object.
For example, double-clicking objects that are grouped accesses the Edit Group mode.

{ewc DIBVIEW, MGXDIBVIEW, !tp250.bmp}
When you click the Edit tool on the Insert toolbar or when you display the shortcut menu, the first 
mode listed is the default editing mode.



Detaching Toolbars

To work more efficiently, you may need to move a toolbar closer to your work area. You can detach 
and move toolbars around the Windows Draw window. You can detach the Insert, Standard, and 
Formatting toolbars. You can also detach the View, CoolShapes, Borders, Shapes, Lines, and 
Connector Lines tool palettes.

To detach a toolbar, click the toolbar 
and drag. When a toolbar is anchored 
along the top or side, you must click 
and drag the area around the buttons.

{ewc DIBVIEW,
MGXDIBVIEW, 
!tp350.bmp}

{ewc 
DIBVIEW, 
MGXDIBVIE
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tp351.bmp}

To reattach toolbars, click and drag the toolbar back to the top or side of the Windows Draw window.
If you do not need a floating tool palette, just close it using the Close button. The tool palette is still 
attached to the original location.
You can also attach tool palettes in the same way you reattach toolbars. For example, you may want
the Shapes tools more readily available.

{ewc DIBVIEW, MGXDIBVIEW, !tp450.bmp}



Keyboard Keys

Keyboard keys can be used instead of the mouse to move and change objects in your drawing.
{ewc DIBVIEW, MGXDIBVIEW, !tp550.bmp}

To select an 
object, use the 
spacebar.

Use the arrow 
keys to move the 
pointer.

With the pointer on a handle, such as the slant or resize handle, press the spacebar while using the 
arrow keys to slant or resize the object. You can also move an object in this manner while the move 
pointer is displayed.



Moving Objects While Drawing

You can draw and move objects simultaneously.

{ewc DIBVIEW, MGXDIBVIEW, !tp650.bmp}

By pressing the right mouse button while drawing, you can move the object to a new location. 
Release the right mouse button (without releasing the left) and complete the object.



Object Selection Option
There may be times when you want to select several objects by drawing a bounding box, but 
another object is in the way.

For example, suppose you 
have several objects on top of 
a large object. When you 
attempt to draw a bounding 
box around the top objects, 
the bottom object is selected 
and moved unintentionally.

{ewc DIBVIEW, MGXDIBVIEW, !
tp750.bmp}

To prevent this problem, you can set an option on the General panel of the Options dialog box.

{ewc DIBVIEW, MGXDIBVIEW, !tp850.bmp}

To set this option, choose Options 
from the Tools menu. Click the 
General tab and click the box for 
this setting. With this option turned 
on, the object on the bottom does 
not move when you try to block-
select the objects on top.

{ewc DIBVIEW, MGXDIBVIEW, !
tp851.bmp}



When working with small objects, you may need a closer look to see the detail. The View tools let 
you magnify objects to any level.

{ewc DIBVIEW, MGXDIBVIEW, !vw150.bmp}



In Windows Draw, there are six tools, located on the Standard toolbar, that let you change the view 
of your drawing.
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Zoom Tools button {ewc DIBVIEW, 
MGXDIBVIEW, !
vw250.bmp}

Zoom In
The Zoom In tool lets you zoom in for a closer look at your drawing. Select the object, then click the 
Zoom In button. You can zoom in as many times as necessary.
Zoom Out
The Zoom Out tool lets you zoom out for a more distant view. Click the Zoom Out button as many 
times as necessary.
View Previous
To go back to the view you were previously using, click the View Previous button.



Zoom Area
The Zoom Area tool lets you define the area you 
want to view. When you click the Zoom Area button, 
the pointer changes to a magnifying glass. Draw a 
bounding box around the area you want to view.

{ewc DIBVIEW, MGXDIBVIEW, !
vw350.bmp}

View Page
Use the View Page tool to view the entire page in the Windows Draw window.
View Actual Size
This tool lets you view the object one-to-one.



You can zoom in on a specific object by selecting the object and choosing Selection from the View 
menu.

{ewc DIBVIEW, MGXDIBVIEW, !vw450.bmp}

The selected object
is magnified to a 
level that fills the 
Windows Draw 
window.



In Windows Draw, you can create some interesting shapes using the Slice and Join commands.

{ewc Mvmci, mvmci, [autostart][noframe] slic0001.avi}
Slice lets you cut one object 
with another. It is like using a 
cookie cutter to shape cookie 
dough.

Join unites overlapping objects 
into one object. The objects are
joined at the overlapping areas.

{ewc mvmci, mvmci, [autostart]
[noframe] slic0002.avi}

The Slice command is also very 
useful for cutting objects in half. 
Draw a line across an object, 
select both the line and the 
object, then use the Slice 
command.

{ewc Mvmci, mvmci,
[autostart][noframe]

slic0003.avi}

You can use Slice with more 
than two objects. The object 
on top of the stack slices into 
all objects below.

 

{ewc Mvmci, mvmci, [autostart][noframe] 
slic0004.avi} Images can be sliced in the 

same manner as other 
objects.
Place an object on top of an 
image and use the Slice 
command to create 
interesting effects.
Note: Slice does not work 
with grouped objects.

Join two or more objects into one object. The objects 
must overlap before you can use the Join command.



{ewc Mvmci, Mvmci,    [autostart][noframe] slic0005.avi}



The Internet has many spectacular Web sites. These Web pages are created by using HyperText 
Markup Language (HTML). With Windows Draw, you can create a Web page without knowing 
anything about HTML.

{ewc DIBVIEW, MGXDIBVIEW, !WEB150.bmp}



To create a Web page, select the Web Page project, then draw objects, use clip art, or add text to the
page. 

{ewc DIBVIEW, MGXDIBVIEW, !
WEB250.bmp}

{ewc DIBVIEW, MGXDIBVIEW, !
WEB251.bmp}

To create a page background, use 
the Page Background wizard. You 
can create a gradient, pattern, 
texture, or custom background.

When you save a Web page, Windows
Draw creates a single graphic from 
objects that touch. For efficiency, 
avoid having objects touch 
unnecessarily.

You should use common fonts for your text, such as Times New Roman. If you want fancy fonts for 
headings, you can convert the heading text to an image or to curves.



{ewc DIBVIEW,
MGXDIBVIEW, !WEB350.bmp}

To create multiple pages, use 
the page tabs at the lower left
corner of the screen. These 
tabs appear when you choose
a Web Page project.

{ewc DIBVIEW, MGXDIBVIEW, !
WEB450.bmp} Web pages can contain links to 

other places. When text or an 
object contains a link, the pointer 
changes to a pointing hand when 
you move the pointer over the link.

A link can jump to another page in 
your Web site, to a different section
of a page, to another Web site, to 
an email address, or to a file that 
can be downloaded by the user.

Set up links using the Hyperlinks 
tab of the Object properties dialog 
box.

You can create animations and place them on your Web page. To create an animation, choose 
Animation in the Blank Page wizard.

{ewc DIBVIEW, MGXDIBVIEW, !WEB550.bmp}

Each page is called a cell. When creating animations, each cell should contain the same graphic as 
the previous cell, but with a slight change. For example, to create a bouncing ball animation, move 
the ball to a different location on each cell. The location of the ball on each cell should mimick the 
path of a bouncing ball.



{ewc DIBVIEW, MGXDIBVIEW, !
WEB650.bmp}

To add cells, click the Add Cell page 
tab in the lower left of the screen.
When you add a cell, the drawing on 
the previous cell is duplicated on the 
new cell. This is so you can easily 
change an object based on its 
previous state.

When you are ready to create the Web page or animation, you can either preview, or save. Use the 
Output Wizard to save your Web page or animation. After you save an animated GIF, you can insert 
it on your Web page with the Insert Picture command.

{ewc DIBVIEW, MGXDIBVIEW, !WEB750.bmp}

You must have a Web 
browser installed to 
view your Web pages. 
When you are satisfied 
with your Web pages, 
you must contact your 
Internet provider for 
information on 
publishing your Web 
pages on the Internet.




